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1 Introduction

Welcome to the £E/7630A-MTP Message Editor User’s Guide for the E7515A UXM Wireless Test Set

(UXM). The purpose of this guide is to provide you with installation instructions and user information
for the E7630A-MTP LTE Message Editor software application. For more information about the UXM
and other UXM software products, refer to the UXM Getting Started Guide and the UXM User’s and

Programmer’s Guide.

Latest Documentation

For the latest version of all documentation, please go to
www.keysight.com/find/UXM-Manuals.

Latest Software Application Releases

For the latest release of all UXM related software, please go to
http://www.keysight.com/find/softwaremanager.


https://http/literature.cdn.keysight.com/litweb/pdf/E7515-90001.pdf
https://http/literature.cdn.keysight.com/litweb/pdf/E7515-90012.pdf
https://http/literature.cdn.keysight.com/litweb/pdf/E7515-90012.pdf
http://www.keysight.com/find/UXM-Manuals
http://www.keysight.com/find/softwaremanager
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2 System Architecture

The E7630A-MTP LTE Message Editor software application runs on PCs using the Microsoft (MS)
Windows 7 operating system. The E7630A-MTP is connected to the UXM via a private Ethernet
interface to enable you to create and modify scenario files for download into the UXM. An example
E7630A-MTP user interface is shown below.
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Figure 2-1: E7630A-MTP Message Editor
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3 E7/630A-MTP Software Installation

Installation Computer Minimum Requirements

For successful operation, the installation computer for the E7630A-MTP LTE Message Editor must
meet or exceed the following specifications:

Minimum System Requirements

Operating System Computer running Windows 7
Communication with Test Set(s) | Ethernet
RAM (Memory) 4 GB RAM (Minimum)
Processor >2.5 GHz Intel Pentium® Quad core or equivalent
.NET Framework Version 4.0 or later
NOTES:

1. Consideration for storage space should be given for storing scenario files and supporting
documentation.

2. A clean installation of the Operating System is required to ensure freedom from Ad-ware,
Spy-ware, updaters and other processor resource consuming applications. For expected
performance, Antivirus software should not be running.

3. Connecting the UXM and the message editor PC to a network is not recommended.

Downloading the Latest Version of E7630A-MTP Message Editor
Software

To ensure you have the latest version, download the E7630A-MTP software from the Keysight
software manager web site. On the www.keysight.com/find/softwaremanager download site,
locate the E7630A-MTP Message Editor Software, and save it to a location on your PC.

Locate the file on your PC and double-click the setup file to install the software. Follow the on-
screen instructions to complete the installation.

Always check the release notes for the latest information about any

NOTE known issues and other important information about your product.

Release notes are available for download from
www.keysight.com/find/softwaremanager.

Transportable License

The Message Editor Software license is transportable. Transportable licenses are identifiable by the
“T” included in their license number such as: E7630A-MTP. This type of license enables you to
move the license from one host instrument or PC to another, without the need to contact Keysight.
Refer to the UXM Getting Started Guide for detailed information about product licenses for your
UXM.

After your first installation of this software to a UXM or PC, you can transport this software to
another instruemtn by running the Keysight License Manager on the original host that currently
has the license, and then transportthe license. (Select Help > Keysight License Manager Help and
search for “transport” to find detailed instructions.)

NOTE Transportable licenses for the E7515A UXM allow you to transport licenses up

to 30 times within the previous 10 days.



http://www.keysight.com/find/softwaremanager
http://literature.cdn.keysight.com/litweb/pdf/E7515-90001.pdf
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Connecting the Computer and Test Set

Connect the E7630A-MTP LTE Message Editor installation computer to the LAN port on the
E7515A UXM rear panel.

E7630A-MTP LTE Message Editor Software

Wired LAN connection

] s r——

E7515A UXM Optional UE client PC

KEYSIGHT

TECHMOLOCES

P TN

Optional second
connection for
MIMQO test

USB connection to client PC

UE under test

Figure 3-1: System Configuration

Launch the E7630A-MTP Message Editor Software

Start the E7630A-MTP LTE Message Editor application from the Windows Start menu by selecting
Start, All Programs, Keysight UXM, E7630A-MTP Message Editor, E7630A-MTP.

10
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4 Menus for E/630A-MTP LTE Message Editor

The E7630A-MTP Message Editor is presented in a single window. Some functions are available
from the menu bar. Frequently used functions are duplicated in the tool bar.

The Menu Bar

File Edit Encode View Window  Help

There are six drop-down menus: File, Edit, Encode, View, Window, and Help. Before any files have
been opened, only two menus are displayed: File and Help.
Using your mouse to select the following menu options performs the described task:

The File Menu

The E7630A-MTP Message Editor works with a file type known as a scenario file which contains
message definitions and defines the desired sequence of messages exchanged between the UXM
and a UE. These file types have an .LBMF file extension.

File | Help

| Mew. Ctrl+M
&¢  Open.. Ctrl+0
Close
Save Ctrl+5
Save Al Ctrl+5hift+5
Save As...
Search Ctrl+F
=" File Transfer...
Print
Exit
Top Level Drop-Down
P . P ; Task Performed
Menu Option Menu Options
File Opens the Drop-Down Menu
New... Creates a new scenario file.
Open... Opens an existing scenario file.
Close Closes the active scenario file.
Save Saves the active scenario file.
Save All Saves all open scenario files.
Save As Save a scenario file with a different
name or location.
Search Enables you to search for text phrases
or terms within a scenario file.
File Transfer... e Downloads a scenario file fothe UXM.
e Uploads a scenario file fromthe UXM.

11
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Print Selects the file for printing.

File (Continued) File, Print Prints selected scenario file.
Tree Print Print an individual message.
File Preview Provides a preview of the selected scenario file.
Tree Preview Prints a preview of the individual

message.

Exit Closes the application.

The Edit Menu

Edit

& Insert Message...

@ Delete All
@ Delete Selected Message

Top Level Drop-Down
Menu Option Menu Command [EBKIFESEe
Edit
Insert Message Inserts a new RRC or NAS
Message into the scenario file.
Delete All Deletes All RRC or NAS
Messages from a scenario file.
Delete Selected Deletes a selected RRC or NAS
Message Message from a scenario file.
The Encode Menu
[ Encode |
wf Encode aAll
w* Encode Selected Message
Top Level Drop-Down
Menu Option Menu Command JEslAElelie
Encode
Encode All Encodes all RRC or NAS
Messages in a scenario file.
Encode Selected Message Encodes a selected RRC or
NAS Message.

The View Menu

View

&%) RRC Editor

NAS Editor
Scenario Editor
Extended Editor

B

Zaan

Properties...
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Top Level Drop-Down
: Task Performed
Menu Option Menu Command
View
RRC Editor Displays the RRC Editor window.
NAS Editor Displays the NAS Editor window.
Scenario Editor Displays the Scenario Editor
window.
Extended Editor Displays the Extended Editor
window.
Properties Displays the properties of the
.LBMF file.
e File Name
e File Path
e Spec Version
e RRC Version
e NAS Version
e Description

The Help Menu

Help |

About... 5

Click About... to display the About (Version Information) Window.

The Tool Bars

The Message Editor Tool bar provides quick access to frequently used functions.
8w E| T Q%

The & icon duplicates the function of File, New (Ctrl+N).

The ™

icon duplicates the function of File, Open (Ctrl+0).
The = icon duplicates the function of File, Save (Ctrl+S).
The = icon duplicates the function of File, File Transfer (Ctrl+S).

The & jcon duplicates the function of View, LTE BSE ME, NAS Editor, Scenario Editor,
Extended Editor

Q

The icon enables the function of Search.

The % icon duplicates the function of View, Properties.

13
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The Scenario File Tool bar provides quick access to frequently used functions.

eee
(i

% E=e| /

The '@ icon duplicates the function of File, New (Ctrl+N).

The = icon displays the Hex viewer window.

The EE icon changes Sorting Type.

The = icon expands All Message List.

The “* icon duplicates the function of Encode, Encode Selected Message.
The E icon expands All Message List in RRC Message window.

The = icon duplicates the function of File, Print.

The “* icon duplicates the function of Encode, Encode Selected Message.

The 4 icon edits Value in RRC Message window.

14
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5 Scenario File Overview

The E7630A-MTP LTE Message Editor provides the ability to create and modify a type of file known
as a scenario file. Scenario files contain message definitions and a desired sequence of message
exchanges at the RRC level between the UXM and a UE. Since many RRC messages also contain
NAS messages, the E7630A-MTP also enables the creation of NAS messages. These can be
included as payload in the generated RRC messages.

The content of the RRC messages also determines lower layer behaviour. For example, the
Bandwidth of the cell is defined using the dl-Bandwidth parameter in the Master Information Block.
Scenario files are downloaded to the UXM via the E7630A-MTP LTE Message Editor, where they are
then selected to run from a menu on the UXM.

Message Editor Fields that can be Overwritten by UXM Front-panel Menu
Keys

When a scenario file is loaded on the UXM, the parameters from the scenario file that have UXM
menu keys associated with them are updated on the UXM to reflect the values from the scenario
file. The table below shows those values from the scenario file that can be changed using the UXM
front-panel menu keys without requiring modification of the scenario file using the E7630A-MTP
LTE Message Editor.

Message Editor Field UXM Menu Key Key Path
freqBandindicator controls which
frequency band is transmitted in Band Cell > Config

System Information Block 1(SIB1).
PA is one of the parameters that
control the power boosting applied
to the PDSCH. It is signaled in the
RRC Connection Setup message.

PB is one of the parameters that

control the power boosting applied

to the PDSCH. It is signaled in the PDSCH PB Power > Boosting
System Information Block 2
message.

dl-Bandwidth determines the
channel bandwidth defined in the
Master Information Block (MIB)
message.

Max-HARQ-Tx controls the number
of times an UL-SCH transmission is
transmitted if it does not receive an Uplink Max HAR@
ACK. (This parameter appears in the Transmissions
RRC Connection Setup message of

the scenario file.)

transmissionMode controls the

transmission mode assigned in the

RRC Connection Setup message. If Transmission Mode Scheduling > Subframes
this value is set to TM3 or TM4, the Configuration

codebook subset restriction field is

also enabled.

PDSCH PA Power > Boosting

DL Bandwidth Cell > Config

MAC/RLC/PDCP > HAR@

15
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Message Editor Field

p-Max is carried in SIB1 and
provides a value for the maximum
power the UE is allowed to transmit.
If this value is not present in the
scenario file, the p-Max On/Off
setting is overwritten, but this
setting is not.

UXM Menu Key

p-Max

Key Path

Power > Power Control

p-Max On/Off determines whether
the p-Max value is present in the
scenario file by controlling whether
the Information Element (IE) is
present or not.

p-Max On/Off

Power > Power Control

p0-NominalPUSCH contributes
towards the power of the PUSCH
and is carried in SIB2.

pO-NominalPUSCH

Power > Power Control

p0-UE-PUSCH contributes towards
PUSCH power and is carried in the
(RRC Connection) Setup message.

pO-UE-PUSCH

Power > Power Control

defaultPagingCycle controls how
frequently the UE can be paged and
is contained in SIB2.

Default Paging Cycle

Function > Paging

nB controls how frequently the UE
can be paged and is contained in
SIB2.

NB

Function > Paging

additionalSpectrumEmission
controls how much leakage the UE
is allowed into adjacent frequencies
and is contained in SIB2.

Additional Spectrum
Emission

Power > Power Control

PDNAddressinformation is the IP
Address assigned to the UE in the
Activate Default EPS Bearer Context
Request message.

Since this is #1, it is the IP address
that is contained inside the (Non-
Access Stratum) NAS Attach Accept
message.

IP Address Type

RRC/NAS > EPS Bearer
Config

drx-Config determines if the DRX
Config IE in the RRC Connection
Reconfiguration message is set to
setup or release.

Connected Mode
DRX

MAC/RLC/PDCP >
Connected Mode DRX

longDRX-Cycle is related to
Connected Mode DRX and is
present in the RRC Connection
Reconfiguration message.

Long DRX Cycle
Length

MAC/RLC/PDCP »
Connected Mode DRX

longDRX-CycleStartOffset is
present in the RRC Connection
Reconfiguration message.

DRX Start Offset

MAC/RLC/PDCP >
Connected Mode DRX

16
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Message Editor Field UXM Menu Key Key Path
onDurationTimer is related to
Connected Mode DRX and is onDurationTimer MAC/RLC/PDCP »
present in the RRC Connection Connected Mode DRX

Reconfiguration message.

drx-InactivityTimer is related to

Connected Mode DRX and is I MAC/RLC/PDCP »
drx-InactivityTimer

present in the RRC Connection Connected Mode DRX
Reconfiguration message.

shortDRX is related to Connected

Mode DRX and is present in the RRC

Connection Reconfiguration MAC/RLC/PDCP »
message. This field controls Short DRX Connected Mode DRX
whether shortDRX IE is present or

not.

shortDRX-Cycle is related to

Connected Mode DRX and is MAC/RLC/PDCP »
present in the RRC Connection shortDRX-Cycle Connected Mode DRX

Reconfiguration message.

shortDRX-CycleTimer is related to
Connected Mode DRX and is MAC/RLC/PDCP »

present in the RRC Connection drxShortCycleTimer Connected Mode DRX
Reconfiguration message.
sr-Configlndex controls the
frequency and on which subframe
scheduling request messages can be Scheduling Request MAC/RLC/PDCP »
sent. (This parameter appears in the Configuration Index  General
RRC Connection Setup message of
the scenario file.)
UL-DL Configuration, used only in
TDD, controls how many subframes
are used for DL tran_sm_lssmn, how 7DD UL-DL _
many for UL transmission and how . Cell > Config
. Configuration
many are special subframes (used
for both). It appears in the SIB1, with
the name subframeAssignment.
Special Subframe Configuration,
used only in TDD, controls the
configuration of the special 7DD Special
subframe - how many symbols of ,
. Subframe Cell > Config
the subframe are used for downlink .
o Configuration
transmission and how many for
uplink. It appears in SIB1, with the
name specialSubframePatterns.
AS Ciphering Algorithm controls the
Ciphering Algorithm selected for use ,
in the Access Stratum. This is RRC .S.‘ecur/ty RRC/NAS > Security
Algorithm

signaled in the RRC layer’s Security
Mode Command.

17
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Message Editor Field

MCC is carried in SIB1.

It also exists in the NAS Attach
Accept message:

in the TAIList

in the Globally Unique Temporary
Identity (GUTI), if it is present

and overwrites both of these values.

UXM Menu Key

mcce

Key Path

Cell » ldentities

MNC is carried in SIB1.
It also exists in the NAS Attach
Accept message:
e inthe TAIlList
e inthe Globally Unique
Temporary ldentity (GUTI), if itis
present
and overwrites both of
these values.

MNC

Cell > Identities

This setting controls the number of

digits of MNC. It is carried in SIB1.

It also exists in the NAS Attach

Accept message:

e in the TAIList

e in the Globally Unique
Temporary Identity (GUTI), if it is
present
and overwrites both of these
values.

MNC Length

Cell » ldentities

NAS Ciphering Algorithm controls
the Ciphering Algorithm selected for
use in the Non Access Stratum. This
is signaled in the EMM layer’s
Security Mode Command.

NAS Security
Algorithm

RRC/NAS > Security

This enables the EPS Bearer ID
associated with each of the
configured Default EPS Bearer
Contexts in the scenario file to be
read back.

Default EPS Bearer
Config # 1 (-4)

RRC/NAS > EPS Bearer
Config

IP Address Type controls what type
of IP address is assigned to the UE in
the Activate Default EPS Bearer
Context Request message. You can
assign an IPv4 address, an IPv6
address, or both an IPv4 and IPv6 to
the UE.

IP Address Type

RRC/NAS > EPS Bearer
Config

18



E7630A-MTP Message Editor
User's Guide

Message Editor Field UXM Menu Key Key Path

V4 Address controls the IPv4
address that is assigned to the UE in
the Activate Default EPS Bearer
Context Request message, if the IP
Address Type selection has enabled
this.

IPv4 Address

RRC/NAS > EPS Bearer
Config

V6 Address controls the IPv4
address that is assigned to the UE in
the Activate Default EPS Bearer
Context Request message, if the IP
Address Type selection has enabled
this.

IPv6 Address IID

RRC/NAS > EPS Bearer
Config

DNS State controls whether a DNS
address will be assigned to the UE in
the Activate Default EPS Bearer
Context Request message.

Number of DNS
Server Addresses

RRC/NAS > EPS Bearer
Config

DNS Address Type controls what
type of IP address (IPv4, IPv6 or
IPv4v6) is assigned as a DNS
address in the Activate Default EPS
Bearer Context Request message.

DNS Type

RRC/NAS > EPS Bearer
Config

V4 DNS Address controls the IPv4
address that is assigned as a DNS
address in the Activate Default EPS
Bearer Context Request message, if
the DNS Address Type selection and
DNS State have enabled this.

IPv4DNS Address

RRC/NAS > EPS Bearer
Config

V6 DNS Address controls the IPv6
address that is assigned as a DNS
address in the Activate Default EPS
Bearer Context Request message, if
the DNS Address Type selection and
DNS State have enabled this.

IPv6 DNS Address

RRC/NAS > EPS Bearer
Config

APN selects the value of the APN
that is assigned to the UE in the
Activate Default EPS Bearer Context
Request. Based on the APN
Overwrite menu key, it is also used
to overwrite the APN in the
Communication Scenario. For more
information, see Access Point Name
on page 30.

APN

RRC/NAS > EPS Bearer
Config

19
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Message Editor Field

APN Overwrite controls whether the
APN is overwritten only in the
Default EPS Bearer Context Request
message, or whether the value also
overwrites the APN in the
Communication Scenario. For more
information, see Access Point Name
on page 30.

UXM Menu Key

UE Requested APN

Key Path

RRC/NAS > EPS Bearer
Config

P-CSCF State controls whether the
IP address of a Proxy-Call Session
Control Function server is supplied
to the UE in the Activate Default EPS
Bearer Context Request message.

Number of P-CSCF
Server Addresses

RRC/NAS > EPS Bearer
Config

P-CSCF Address Type controls what
type of IP address (IPv4, IPv6 or
IPv4v6) is assigned as the IP address
of the P-CSCF server.

P-CSCF Type

RRC/NAS > EPS Bearer
Config

V4 P-CSCF Address controls the
IPv4 address that is assigned as the
IP address of the P-CSCF server -
assuming the P-CSCF State has
enabled this.

IPv4 P-CSCF
Address

RRC/NAS > EPS Bearer
Config

V6 P-CSCF Address controls the
IPv6 address that is assigned as the
IP address of the P-CSCF server -
assuming the P-CSCF State has
enabled this.

IPv6 P-CSCF
Address

RRC/NAS > EPS Bearer
Config

Cause Code State controls whether
the Activate Default EPS Bearer
Context Request message will
contain a Cause Code (which usually
indicates a requested service is not
available)

Cause Code controls the cause code
that will be contained in the Activate
Default EPS Bearer Context Request
message, assuming the Cause Code
State has enabled this.

Cause Code

RRC/NAS > EPS Bearer
Config
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6 Creating a New Scenario File

It is often easiest to start with an existing scenario file as a template and make modifications from
that. However, you may want to create a new scenario file to use as a completely blank canvas.

&

1. Click New Insert Icon or Click File, New

File  Help

RRC Messages | MAS Messages

PDU Type Insert Message

Type Type MName Value
BCCH-BCH-Message

BCCH-DL-SCH-Message
MCCH-Message
PCCH-Message
DL-CCCH-Message
DL-DCCH-Message
UL-CCCH-Message
UL-DCCH-Message

| pelete |[ ok | [ cancal

Figure 6-1: Creating New Scenario File

2. Click the OK button. This creates a new, blank, scenario file.

3. Save this under an appropriate name before making further edits to it.
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/ Moadifying a Scenario File

After you save a new scenario file or open an existing one, you see four tabs at the bottom left of the
scenario file window, which enables you to access the various functions of the E7630A-MTP
Message Editor. They are described in each of the sections below:

The RRC Window

NAS Window

Scenario Window

Extended Window

File Transfer

Examples of Common Changes
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The RRC Window

P bd

The E7630A-MTP LTE message editor provides a comprehensive tool for generating and
manipulating RRC (Radio Resource Control) messages.

The RRC Message List box displays all the user defined RRC messages. By clicking on the Insert
Message button, you can easily insert, delete, and edit RRC messages. You can select an
individual message on the list to view its structure and parameters on the Message Structure box
to the right of the RRC Message List.

i Keysight E7630A-MTP e Editor - [TDD_20_4_17 TM1LBM =k

j File Edit Encode VYiew Window Help - 7 X
E m A T O %
TDD_20_4_17_TM1.LBMF |
)=8L &% ESe|
=-RRC Message List =¥ Message Name : RRCReconfiguration -
- MIB =-Ta DL-DCCH-Message r
51 B§u1 message e
.. 8IB2 B el
St =-Fg reConnectionRecanfiguration W
- Selp g mre-Transactionldentifier : 0
~DL_Aut -8y criticalExtensions
..DL_Sec &8, cf
.. Sec_mod_com BF_; rrcConnectionReconfiguration-r8
.. UECap o measConfig + Optional
WRRCReconfiguration mobilityContrallnfo @ Optional
- 5IB3 %y dedicatedinfolASList
 RRCRelsse [ enmr ISEQ 1: 0?4202[5DUEdq&lUDBUUDUdUUIDEZDICIUSDEBDBDBD
DL DETACH ACCEPT BE; radioResourceConfigDedicated
R . E-Tg sb-ToAddModList =
-.DL_DETACH_RECQ_NO_REATTACH a| T l| -
.. TAC_ACCEPT
- paging Detail Information | Qutput | Hex Viewer
.. RRCRecfg_noMNAS
.- RRCRecfg_meas_only Name Value
-. RRCRecfg_with_mobility_control Message Name RRCReconfiguration
..Ded_EPS_bearer_establishment Message Type DL-DCCH-Message
- RRCReleseForTAU Encoded Data 0x200601C83A1017003203200400002000EA900E08482DEDEDEDEFDTD
- 39550RelForTAU Encoded Length Data 71
Decoded Data equal
Elrre |Enas |Edscenaro |EdExtended || il '

Figure 7-1: RRC Message Structure
Click on the Insert Message icon. The window below is displayed.
Select the PDU Type (Protocol Data Unit) of message you would like to include.
Double-click or drag and drop to insert it into the Insert Message window.

Name the message by double-clicking in the Name column and typing the desired name. (For
example: “Master Information Block”)

23



E7630A-MTP Message Editor
User's Guide

RRC Messages | MAS Messages

PDU Type Ingert Message
Type Type MName Value
BCCH-BCH-Message BCCH-BCH-Message Master Information Block

BCCH-DL-SCH-Message

Figure 7-2: Insert a New Message Type

5. A message can be created directly by inserting a hex value into the Value column or this can be
left blank.

6. Click the OK button.

A new message now appears in the RRC Message List.
If the message name appears in red, this indicates that it still needs to

NOTE be encoded. To encode a message, select either of the

the top of the new message windows.

icons at

If a hex value has been specified for the message, a decoded RRC message corresponding to that
hex value appears on the right-hand side, when the message name is highlighted.

If the hex value has not been specified, a blank message corresponding to the selected PDU type
appears in the right-hand side.

— Keyioht E7630AMTD

File Edit Encode View Window Help

E wH T O AR

Bloes ES e
=-RRC Message List B---E&“ Message Mame @ Master Information Block
.. Master Information Block =-Tg BCCH-BCH-Message

=-Tg message
&g dl-Bandwidth : nf
£-Tg phich-Config
@ phich-Duration @ normal
& phich-Resource @ oneSixth
o systemFrameMNumber @ '00000000° length &
“oman spare t0000000000° length 10

Detail Information | Cutput | Hex Viewer

Name Value

Message Mame Master Information Block
Message Type BCCH-BCH-Message
Encoded Data 0x000000

Encoded Length Data 3

Decoded Data equal

Eorrc |ETINAS |EBscenario |E¥Extended

Figure 7-3: New RRC Message
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The fields of the message can be manipulated by selecting a modifiable parameter on the right-
hand side, right-clicking and selecting Change Value. Depending on the field type, a value can
either be entered directly, or chosen from an enumerated list.

Any applied changes to an RRC message on the list are not finalized
unless the message is encoded again.

Detail Information | Output | Hew WViewer Detail Infarmation | Omtput | Hex Yiewer Detail Information | Output | Hex Viewer
Narme Walue This Message [MasterlnformationBlock] Encade Success | Name Tupe Value
. old Encode Value : 0x690C43 "
Message MName MasterinformationBlock |10 Froide Valne | O=590C23 MasterlnformationBlock  BCCH-BCH-Message  0x630C43
Message Type BCCH-BCH-Message
Encoded Data 0x690C43
Encoded Length Data 3
Decoded Data equal

Figure 7-4: Detail Information - Output - Hex Viewer

The Input box (the top-right-side window, where you can change values) shows a brief summary of
a selected item. Once you encode an item, the result is shown in the Output box.

NAS Window

Non-Access Stratum (NAS) Editor enables you to easily generate and decode encoded HEX NAS
data. These are very important features to create a wide range of UXM scenario files. Generated,
encoded HEX NAS data can be used in the E7630A-MTP to generate RRC messages containing
NAS data; any received NAS messages on the eNodeB emulator side can be decoded for
debugging.

It is not sufficient to construct an NAS message for it to be included in
a scenario file - the hex content associated with the NAS message
must appear inside an RRC message for it to be sent to the UE during
a message exchange. This can be easily accomplished from the RRC
menu tab, by right-clicking on the NAS field and selecting the NAS
message you wish to include from the drop-down list. See step #7 on
page 46 as an example.
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] L NAS Message Insert

Messsage Type Hex Value Input

@ DL EMM & ESM Message

~ A

0 UL EMM & ESM Message pply

Type Mame Insert Message

Message m Type Mame

ATTACH_ACCEPT DL_EMM ATTACH_ACCEPT

ATTACH_REJECT
AUTHENTICATION_REJECT
AUTHENTICATION_REQUEST
CS_SERVICE_NOTIFICATION

DETACH_ACCEPT_DL

DETACH_REQUEST_DL

DOWNLIMK_NAS_TRANSPORT

EMM_INFORMATION

EMM_STATUS_DL

GUTI_REALLOCATION_COMMAND

IDENTITY_REQUEST

SECURITY_MODE_COMMAND
SECURITY_PROTECTED_MNAS_MESSAGE_DN
SERVICE_REJECT

TRACKING_AREA_UPDATE_ACCEPT
TRACKING_AREA_UPDATE_REIECT
ACTIVATE_DEDICATED_EPS_BEARER_CONTEXT_REQUEST
ACTIVATE DEFAULT_EPS BEARER_CONTEXT_REQUEST
BEARER_RESDURCE_ALLOCATION_REJECT
BEARER_RESOURCE_MODIFICATION_REIECT

m

[ Delete ] [ Delete Al ] [ 0K ] [ Cancel

Figure 7-5: NAS Message Insert Window

To generate a new message, first select one of the DL/UL radio buttons in the Message Type box.

NAS Message Insertion Procedure
1. Click the Insert Message icon or Edit, Insert Message.
2. Select Message Type.

Messsage Type
@ DL EMM & ESM Message

) UL EMM & ESM Massage

3. Select Message.
4. Double-click or drag and drop to the Insert Message window.
5. Click OK button.

Linking a NAS Message to an RRC Message

Linking NAS messages to RRC messages enable you to update the NAS message parameter and
automatically update the RRC message containing the NAS message.

1.
2.

Select an RRC message that contains a NAS message.

Right-click on the parameter you wish to change in the NAS message list. In the example
below, RRC Reconfiguration is the RRC message that contains the dedicatedinfoNASList. As
shown, right-clicking on SEQ 1 displays a ‘Change NAS’ choice.
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" FDD_Combined 6.3 _with_Linking.lomf [E=R(EEH =<
o Ele/ @Y E]E""V
[ RRC Message List E--T:"i" Message Name : RRC Reconfiguration -
MIB -Fg DL-DCCH-Message

-SIB1 3oy, message L

-SIB2 B i

- Setup Bh rreConnectionReconfiguration L4

- DL Authentication ~fg¥ mc-Transactionldentffier : 0

- DL Security Command E-En criticalExtensions

~Security Mode Command B

- anahiliy Foguiny =--Pg rrcConnectionReconfiguration-r8

measConfig : Optional

~RRC Release Other

=B dedicatedInfoNASList

~Page TMSI

- Measurement Report ~#EE EIZ0 M ATTACH ACCEPT

-DL TAU Accept (=-F3 radioResou A]TACHACCEPT

~DL Defach Accept T8 §0-Tod ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST

-RRC Reconfiguration Re-entry E--;':; SEQT

-RRC Reconfig Second Context -fg¥ srb-ldentity : 2

~Page Agient IMSI &3y, rlc-Config "

~RRC Release TAU al i -

~Measurement Report B13

- Measurement Report B17 Detail Information | Output | Hex Viewer

-RRC Reconfig TAU Accept
Name Value it
NAME SEQ1
BuittinName OCTET STRING E
Refliame DedicatedInfoNAS
HEXSTR Len 48 L4
HEXSTR (074202E0064000F110000100145201C1010908076167696C656E740501C0AB0133500BF600F110012301AABBC

EERRC |EEINAS | EZScenario | EdExtended Ej‘\“ R T ST 1, 3

Figure7-6: Linking ATTACH_ACCEPT to RRC Reconfiguration Message
Selecting ‘Change NAS’ enables you to choose the NAS Message you wish to link. In this
example, ATTACH_ACCEPT is selected.

Select ‘Enter’ on your keyboard or click in any of the white areas of the software user
interface. Notice that the value for SEQ 1 has changed.

Select the encode Message icon at the top of the screen and verify the encoding was
successful by the text shown in the Output tab section at the bottom of the display.

The NAS message is now linked to the RRC message, so any changes made to the NAS
message can be automatically updated in the RRC message if you choose. Refer to a
continuation of this example in Changing the Initial DUT IP Address on page 39.
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Scenario Window

The Scenario Editor provides a simple interface for you to create and modify various test
scenarios for the eNodeB emulator. Use the DL RRC messages (which may contain NAS data)
defined in £7630A-MTP LTE Message Editor software as well as those you have pre-defined. Each
scenario is divided into two sub-scenarios:

. Start Scenario

. Communication Scenario

Start Scenario

The Start Scenario window defines master information block and system information block
messages that are broadcast by the UXM; you can double-click or drag and drop to place a
selected MIB/SIB message in Start Scenario box. The index in the Start Scenario box indicates the

order of message transmission from eNodeB. You can define three sets of SI messages with
different numbers or types.

MIB Type Message

Master Information Block MIB

SIB Type MeszageMName(Set 1) MessageMame(Set 2) MessageMName(Set 3)
System Information Block Type 1 3181

System Information siB2

System Information SIB3

4 {1 I

Figure 7-7: Start Scenario Window

Communication Scenario

The Communication Scenario window defines the desired message exchange between the UXM
and a UE. The UL RRC Message contains the name of a standard RRC Message (for example,
rrcConnectionRequest). The right-hand DL RRC Message column contains the name of the
message that is sent to the UE as a result of receiving the UL RRC Message Type. The messages

in the DL RRC column are those that have been constructed by the user and appear in the RRC
Window.

Some UL RRC messages can carry NAS messages inside them. For those messages, it is possible
to further qualify the DL RRC message that are sent based on the NAS content of an UL RRC
message. So, for a received UL Information Transfer message at RRC, different DL RRC messages

could be sent to the UE depending on the NAS message that was carried inside the UL RRC
Message.
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RRE_CORNECTION |
(i _ueh S0 Rl Exl_S wach_R 5
UL AL Message S & el D FRC iasaai Saizhia Tan
meCannichonR ksl Seup
meGonnechonTalupin . ATTACH _REGUEST DL iaSwricabon
ultfcemamenTransin  GUTHENTICAION . DL dclarioalion
ulnfoesgfionTrangler  AUTHEMNTICATION . (AL Secusty Command
ulnfoesgmenTranaler  SECURITY_WODE . DL ESUinlwmabon Regi.  RAC COMNECTON 1
EA_BEFCRUATIO

lnformalion Transe Scurily Mo Command

Figure7-8: Communication Scenario Window

There are ten tabs in the Communication Scenario window:
e RRC_CONNECTION (Initial Attach) - This tab shows those messages and events related to
the initial attach.

e RRC_CONNECTION_T (Service Request) - This tab shows those messages and events
related to the UE requesting service.

e RRC_CONNECTION_2 (TAU Request) - This tab shows those messages and events related
to a Tracking Area Update (TAU), required when performing handovers as it updates the
UE location to the enodeB.

e RRC_CONNECTION_3 (Ext Service Request) - This tab shows those messages and events
related to an extended service request.

e RRC_CONNECTION_4 (Detach Request) - This tab shows those messages and events
related to a detach request.

e RRC_CONNECTION_5-9 - These tabs store information inside the ASCII file generated by
E7630A-MTP Message Editor in the same way the content from the other tabs is stored.
You can switch to these tabs after sending a message by selecting from Goto Next Tab or
manually select the tabs to use by sending an RUI command.

You can change the NAS message from this view by double-clicking the message and then making
your selection from a drop-down list, as shown below.

File Edit Encode View Window Help
B =8OS
TDD_20_4_17_TM1.LBMF
[E” [S) = M Editing [
MIB Typea
= Start Scenario Message
LomiB qr UL RRC Message : ullnformationTransfer [UL_DCCH]
SiB1
=P SIB Type
_____ siB3 System MNas Message [UL EMM MESSAGE -]
=~ Communication Scenaric Message System [A‘ITACH_COMF'LETE v]
= UL_CCCH System |
L. rreConnectionReestablishmentRequest
: ! rrcConnectionRequest L 5
- UL_DCCH .
- csfoParametersRequestCDMAZ000 N L
- MeasurementReport o
rrcConnectionReconfigurationComplete < [l TFT Operation Code e—
rrcConnectionReestablishmentComplete f—
rrcConnectionSetupComplete Cormmmull ES T er Reques PO e Re est
.. securityModeComplete
- securityModeFailure RRC_
.. ueCapabilityinformation co. DL RRC Message [DL*Aum v]
ulHandoverPreparationTransfer UL RR
ullnformationTransfer rreConlil
counterCheckResponse rreConrl|  Goto Next Tab [RRC_connECTION -
- uelnformationResponse-r9 ulinforall|
- proximitylndication-rg
... MReconfigurationComplete-r10 ulinfors [ OK | [ cancel |
mbmsCountingResponse-r10 securitgy
interFregRSTDOMeasurementindication-r10 uecapamv — RRCHe conmguraton
ullnformationTransfer DETACH_REQUES... DL_DETACH_ACCEPT
< T | r
EfrrC |5|N.n.s EZ scenario |ESExtended

Figure 7-9: Changing NAS Messages
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5% Message Editin
g g

UL RRC Message :  rrcConnectionSetupComplete [UL_DCCH]

Nas Message UL EMM MESSAGE ~|

[ATTACH_REQUEST -

DL RRC Message : [DL Authentication v]
l oK ] [ Cancel ]

Figure 7-10: Qualifying Message Response to UL NAS Message

As well as qualifying a message response based on the UL NAS message that is being carried,
there is the option to further qualify the response to certain messages based on message content.

Access Point Name

The PDN Connectivity Request message can carry information on the Access Point Name. It is
possible to determine the response needed to be sent, based on the Access Point Name carried
inside the message. This means that different responses can be sent in response to different PDN
Connectivity Request messages.

The UXM front-panel menu-key, UE Requested APN, represents the Access Point Name that the
UE is requesting a connection to in the PDN Connectivity Request.

E Message Editing | E3 |
UL RRC Message :  ullnformationTransfer [UL_DCCH]
Nas Message  |UL ESM MESSAGE -|
|PDN_CONNECTIVITY_REQUEST -|
7] Access Point Name
5
0
0
DL RRC Message :  RRC Reconfig Second Context -
[ oK ] [ Cancel ]

Figure 7-11: Different Responses Available to PDN Connectivity Request Message

The PDN Disconnect Request message specifies an EPS Bearer Identity associated with the PDN
that the UE is requesting to disconnect from. Specifying a value in the Linked EPS Bearer ID field
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enables precise specification of the Deactivate EPS Bearer Context Request message that the UXM
should send to the UE.

'E Message Editing @

LIL RRC Message @ ullnformationTransfer [LL_DCCH]

Mas Message LL ESM MESSAGE ']

|PDN_DISCOMMECT _REQUEST - |

Linked EPS Bearer ID

DL RRC Message : DL Deactivate EPS Bearer Context Request v]

(04 ][ Cancel ]

Figure 7-12: Specifying a Value in the Linked EPS Bearer ID Field

The Bearer Resource Allocation Request is a request from the UE that a Dedicated Bearer is
established. The message can include different EPS Bearer Identities and different QCI values
inside it. The Linked EPS Bearer Identity represents the Default Bearer with which the UE would
like the Dedicated Bearer to be associated. The QCl value corresponds to the requested quality of
the Dedicated Bearer. This provides the flexibility of choosing different DL RRC Messages that can
be sent in response to combinations of these two parameters. These different messages can
activate different Dedicated EPS Bearer Contexts.

E Message Editing IEI
UL RRC Message : ullnformation Transfer [UL_DCCH]
Mas Message [uL ESM MESSAGE - |
[ BEARER_RESQURCE_ALLOCATION_REQUEST - ]
Linked EPS Bearer ID
o

Qcr
DL RRC Message : | Dedicated Bearer Addition ~|

[ oK ] [ Cancel ]

Figure 7-13: Selecting Default EPS Bearer IDs and QCI Values
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The ESM Information Request is a request from the UE that the APN information is transferred
after the NAS Security Mode procedure is completed. You can perform the ESM Information
Request/Response procedure by checking the ESM Information Transfer Request in PDN
Connectivity Request? box,

7 Message Ediing

UL RRC Message : ullnformationTransfer [UL_DCCH]

Nas Message  [UL EMM MESSAGE v
| SECURITY_MODE_COMPLETE v
Access Point Mame
Linked EPS Bearer ID 5
Default EPS Bearer ID 0
Qcl 0
TFT Operation Code Add TET

ESM Information Transfer Request in POM Connectivity Request 7

DL RRC Message - [DL_Sec v]

Goto Mext Tab - [ v]

OK H Cancel ]

Figure 7-14: Selecting ESM Information Transfer Request in PDN Connectivity Request?
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Measurement Report

The Measurement Report message can carry a different measurement identity (or MeasID). A
different response can be sent to measurement reports containing different measurement
identities — allowing a certain report to trigger an automatic redirection to another cell, for
example.

E®e| 7/
triggerQuantity : rsrp -

- MIB reportQuantity : sameAsTriggerQuantity
- §IB1 g maxReportCells : 1
- SIB2 @ reportinterval : ms120
- Setup reportAmount : rl
- DL Authentication si-RequestForHO-rg
- DL Security Cormmand ue-RxTxTimeDiffPeriodical-rd
- Security Mode Command - || b e 1% measldToRemaovelist
- UE Capability Enguiry E—Jﬁ measld ToAddModList
- RRC Reconfiguration =-Tg SEQ 1
- RRC Release Other O@T—|
- Page TMSI E 9 measObj Change Value o
- Measurement Report 9 reportConfigld = 1
- DL TAU Accept =-Tg quantityConfig |
- DL Detach Accept = ?_g quantityConfigEUTRA 1
- RRC Reconfiguration Re-antry P fitterCoefficientRSRP : fc0
- RRC Reconfig Second Context fitterCoefficientRSRQ : fco g
- Page Agilent IMSI quantityConfigUTRA : Optional
- RRC Release TAU quantityConfigGERAN : Optional
- RRCReconfig TAUAcCcept guantityConfigCDOMA2000 : Optional -
- MeasRpt_HO
- RRC Reestablishment Detail Information | Output | Hex Wiewer
- EMS_Info_Req
-~ NAS_Identity_Req MName Value
- 5184 NAME measld
- RRC_Handover_A_to_B BuittinMame INTEGER

Reftlame Measld

Constraints (1...32)

EYRRC |EEINAs |EAscenario |ESExtended

Figure 7-15: Different Measurement Identity Available for Message Report Message
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Extended Window

Using Extended Window, you can add a message that has been defined in the RRC message
window to the Custom Message, Page Message, Release Message, or Handover Message pane.

- Keysight E7630A-MTP N

C| File Edit Encode View Window Help - 5 X

B m B T O Q4 %

E;E Custom Message List Release Message List

- Messages Name MName
- MIB Ded_EPS_bearer_establishment RRCRelese
- SIB1 DL_DETACH_REQ_MO_REATTACH
- 5182 RRCReleseForTAU
- Setup 39550RelForTAU
- DL_Auth
.. DL_Sec
.. Sec_mod_com
.. UECap
- RRCReconfiguration
.. 8183 < 1 3 < 1 3
.. RRCRelese
.. DL_DETACH_ACCEPT Paging Message List Handover Message List
- DL_DETACH_REC_NO_REATTACH Name Name
TAC_—ACCEPT paging RRCRecfg_meas_only
- paging RRCRecfg_with_mability_control
.. RRCRecfg_noMNAS
.. RRCRecfg_meas_only
.. RRCRecfg_with_maobility_control
.. Ded_EPS_bearer_establishment
- RRCReleseForTAU
-~ 39550RelForTAU

Frrc |Evas | B scenaro (B Extended l = dljg|E = -

Figure 7-16: Extended Window

Extended Message Insertion Procedure
1. Select a message in the All Message View.
&F

P custem
i

2. Select message and click the ﬂJ icon (All/Custom/Release/Paging/Handover.)
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File Transfer

A scenario file must be transferred to the UXM before it can be run. This is done using the
procedure below.

File Transfer Procedure

1. Click = icon from the main tool bar or select File, File Transfer.

o Keysight E7630A-MTP Message Editu_

File Edit Encode View Window  Help
] B B T O-Q %

2. Check the IP Address (for example: 192.168.1.60).

IP Address : 19 . 168 . 1 . 50 | Comneat || close |
3. Click Connect Button.
4. Click the check box from the File Name list.
5. Click icon

6. The file is transferred to the scenario file directory
D:\ProgramData\Keysight\E7515A\E7530A_E7630A\Scenario Files\User

in the UXM. A message indicates whether the message has been successfully transferred.

7. On the UXM, select Call Scenario > Load to see the list of available scenario files, and
check that the file you downloaded is listed.

select "Load Scenario File'

Cument Folder: D-\ProgramDat vaighty 330A_ET630A\Scenano Files\User

Type Data Modified

Parent Folder

Figure 7-17: Verifying a Successful Download
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Examples of Common Changes

Setting the Channel Quality Indicator (CQI) Value
1. Locate the rrcConnectionSetup message on the RRC message tab. The cqi-ReportConfig

Information Element is near the bottom of this message.

é @/ =EErd
-- RRC Message List i betalftset-COl-Index : 2
LoMe - Tg uplinkPowerContralDedicated
. s1B1 P g p0-UE-PUSCH : 0
i oi@2 @@ deltaMCS-Enabled @ enl
i i fg accumulationEnabled : TRUE
! g pO-UE-PUCCH : 0
| DL_Auth | P pSRS-Offset : 3
i~ DL_Sec i i fikerCoefficient © fcd
i~ Sec_mod_com i~de: tpo=PDCCH=ConfigPUCCH
L UEcap i-du tpe-PDCCH-ConfigPUSCH
- RRCReconfiguration
L siB3 e, soundingRs -UL-ConfigDedicated
|~ RRCRelese i %?-;:ti:qﬁl;iﬁ'alue
DL_DETACH_ACCEPT 4 . transmissionMode - i1
DL_DETACH_REQ_NO_REATTACH =By codebookSubsetRestriction
i TAC_ACCEFT e 2 Twdrtenna-tm3 : 00" length 2
i~ paging : -1-8ay, ue-TransmitAntennaSelection
[ RRCRecfo_nohAS L42% release
i RRCRecfg_meas_only = %2y schedulingRequestConfig
.. RRCRecfg_with_mability_control | ©-Pg setup _
- Ded_EPS_bearer_establishment g SL_EUEE':I:EE‘??L";CEIH':'EH +0
i~ RRCRelesaForTAL
L. 39550R elForTAL Detail Information | Cufput | Hex Viewer
tame Value
MNANME coi-ReportConfig
BulltinName SEQUEMNCE
RefMame Cal-ReportConfig
|E Addition

Figure 7-18: Accessing CQI Reporting
2. The Information Element (IE) may not be present in the message - which indicates to the
UE that CQI reporting is not being configured in this message. To include the IE, highlight
the cqgi-ReportingConfig field as shown above and notice that an IE Addition box becomes
available under the Detail Information tab. Select the box marked IE Addition. This enables

the cqi-ReportConfig information to become visible as shown below.
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B R N PR LR IR [N Ly |
ey t|:|c POCCH- Cnnf‘gPLISCH
=829 coiReportConfig
-§gd caqiFReportModeAperiodic : rm12
----- g nomPDSCH-RS-EPRE-Offset @ 0
- Enq, cqi-ReportPeriodic
et relegse
=+ soundingRS-UL-ConfigDedicated
D 391 antennalnfo
i defaultvalue
D 9=1 schedulingRequestConfig
=-Tg setup
Q sr-PUCCH-ResourceIndex @ 41
&g sr-Configindex : 27
“-Rgl dsr-TransMax : n16

mi Dnm s e fin

A0 « Ainticanes
Detail Information | Output | Hex Viewer
MNarme Value
NAME cqi-ReportConfig
BuiltinMarme  SEQUEMCE
RefMame CQI-ReportConfig

IE Addition

Figure 7-19: Enabling CQI Report Configuration

3. Disable Aperiodic CQI reporting, by highlighting the cqi-ReportModeAperiodic field and de-

selecting the IE Addition box.

+ TPC-HULLH-LONTIgF USLH
I_’_I Ea cq»—RepnrtCnnfg
:

i nomPDSCH-RS-EPRE-Offset : 0
-=: cgi-ReportPeriodic

-=: soundingRS-UL-ConfigDedicated
I'_'l 3'01 antennalnfo
1 defaultValue

D 3:-1 schedulingReguestConfig

=8 Eg setup

gl sr-PUCCH-Resourcelndex : 41
-~ §g? s-Configindex : 27

------ ‘gl dsr-TransMax : n16
cgi-ReportConfig-v920 : Optional

artam =T A0 = COimdimea]

Detail Information | Output

Hex Viewer

Mame
MAME

Value

cgi-ReportModeAperio...

BuitinMame  ENUMERATED
IE Addition [

Figure 7- 20: Disabling Aperiodic CQI Reporting

4. Enable Periodic CQI reporting, by right-clicking the cqi-ReportPeriodic IE and selecting

‘setup’ from the drop-down list of possible options.

37



E7630A-MTP Message Editor
User's Guide

EIE; .qi-RepnrtCDnﬁg_
it cgi-ReportModeAperiodic
g nomPDSCH-RS-EPRE-Offset : 0

< ¥ E T g
o release
- soundingRS-UL-Config

=-8e, antennalnfo

Eﬁul schedulingRequestConfig

=-Tg setup
G sr-PUCCH-Resourcelndex : 41
g sr-ConfigIndex : 27
g dsr-TransMax : n16
cgi-ReportConfig-v920 : Optional
antennalnfo-va20 @ Optional

&y rif-TirmersandConstants-rg

manCritieslCurtnneine « et

Detail Information | Output | Hex Viewer

MNarne Value

MNAME cgi-ReportPeriodic
BuittinMame  CHOICE

RefMame CQI-ReportPeriodic

IE Addition

Figure 7-21: Enabling Periodic CQI Reporting
5. The most basic type of CQI reporting is Periodic Wideband CQI reporting. Setting the values
shown in the diagram below enable this.

=-8ey cgi-ReportPeriodic
T8 setup
Q coi-PUCCH-Resourcelndex | 0
& coi-pmi-Configindes ; 26
= 201 cii-FormatindicatorPeriodic
“HwidebandCal
fod ri-Configlndex
@ simultaneousAckMackAndCal: TRUE

Figure 7-22: Settings for Periodic Wideband CQI Reporting
6. Make sure you encode the message by clicking the encode Message button. The Setup

message in the RRC Message List changes its color, from red to black, indicating the
message is encoded.

NOTE If you navigate away from the message before selecting the encode

Message button, your changes are lost.

7. Select File, Save As..., and save the file with a new name, retaining the .LBMF extension.
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Changing the Initial DUT IP Address

In this example, you will change the Initial DUT IP Address in the
ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST message and automatically update the
RRC Reconfiguration message with this new value.

1. You should already have an ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST
message in your NAS Message List. If not, refer to the “NAS Message Insertion Procedure”
on page 26 to include one.

2. If you have not already done so, use the “Linking a NAS Message to an RRC Message” on
page 26 to link the ATTACH_ACCEPT message to the RRC Reconfiguration message.

It is best to link NAS messages to the RRC messages because this

NOTE enables all NAS message value changes to be automatically updated
in the RRC messages to which they are linked.

For this example we are also going to link the
ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST NAS message to the ATTACH_ACCEPT
message.

3. On the NAS window tab, select the ATTACH_ACCEPT message. Notice the
ESMMessageContainer parameter in the Input window on the right-hand side.

4. Right-click on NasMessageDnData and select ‘Change NAS ESM'.

OBl @/ E=e| 7/
=- NAS Message List =-F§' Message Name : DL EMM Message
-8y, ATTACH_ACCEPT
ACTIVATE DEFAULT_EPS_BEARER_CONTEXT_REQUEST P SecurityHeaderType : 0
. EPSAttachResult : combined EPS/IMSI attach (2)
g SpareHalfOctet : PRESENT
By, T3412Value
o . Unit : value indicates that the timer is deactivated (7)

----- Hg# Timervalue : 0

Value Change
Change NAS ESM |

\-§gi spare : PRESENT
g OddEven : PRESENT

g IdentityType : PRESENT
fig MCC1 : 0

Figure 7-23: Settings for Periodic Wideband CQI Reporting
5. Select the ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST message.

6. Encode the new NAS ESM message by selecting the encode Message icon at the top of the
window. The following information message pops-up:
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Informing

This MAS message is embedded inside a message[RRC Reconfiguration®0] in the
RRC list.
Do you want to apply to RRC list?

Coe [

Figure 7-24: Applying NAS Message Update to RRC Message

If you do not see the above message, then this NAS message is not
linked to any RRC message and you will have to go back to the RRC
window and perform the linking procedure as described above or copy
and paste the hex values as required in previous versions of £/76304-
MTP Message Editor software.

7. Select ‘Yes’ because you want this new value to be applied in the RRC message. Notice the
“Encode Success” message is now displayed in the Output tab window. You now have
linked the ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST NAS message to the
ATTACH_ACCEPT message, so any changes to either of these messages are reflected in the
RRC Reconfiguration message.

8. Right-click the PDNAddressInformation entry and select ‘Value Change’ when it pops up.
The IP address field is now available to be changed.

o e @ /L E-F‘"/
=I- NAS Message List =-#§' Message Mame : DL ESM Message
-~ ATTACH_ACCEPT =By, ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST
‘- ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST - igP EPSBearerldentity : 5
g ProcedureTransactionIdentity : 1
-8y, EPSQ0S
R+ Nolu !

=-Bey, AccessPointMame
i b payt :agilent
_Q_nl PDNAddress
g spare : PRESENT
i PDNType : IPv4 (1)

e PDMAddressInformation f192.168.1.51

Figure 7-25: Changing the IP Address

9. Enter the new IP address you wish to use.

10. Encode the new IP address by selecting the encode Message icon at the top of the window.
The following information message pops-up:

Informing

This NAS message is embedded inside a message[RRC Reconfiguration®0] in the
RRC list.
Do you want to apply to RRC list?
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11. Select ‘Yes’ because you want this new value to be applied in the RRC message. Notice the
“Encode Success” message is displayed in the Output tab window.

12. Go to the RRC window and notice the RRC Reconfiguration message has turned red. When
you select this RRC message you can see that the value for SEQ 1 has changed. Select the
encode Message icon. The Output tab window now displays “Message is Encoded!”. The
RRC Reconfiguration message is now black, which also verifies encoding is successful.

Signaling Other Addressing Options

The ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST message is also the method for
signaling other addressing options.
e Right-clicking on the message header displays a list of these options.

e Left-clicking on each of these options adds additional fields to the message.

It is possible to enter a list of separate addressing options within a single message. In the example
below, ContainerCfgs is set to 3, enabling you to provide 3 addresses to the UE when the
ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST message is transmitted to the UE. This
example sets one P-CSCF and two DNS addresses.

=]/

=¥’ Message Name : DL ESM Massage
9"20_1 ACTIVATE_DEFAULT_EPS_BEARER_CONT 7 o ~

[=1- NAS Message List
~ SECURITY_MODE_COMMAND

~ ATTACH_ACCEPT g EPSBearerldentity : 5 Transactionldentifier
- ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST : 0 ProcedureTransactionIdentity @ 1 Negotiated QoS
3%353&5_ . NegotiatedLLCSAPL
8oy, AccessPointhame RadiaPriarity
.- text : agilent PacketFlowldentifier
(g2, PDMAddress
g spare : PRESENT ARHAMER
- @ PDNType : IPv6 (2) ESMCause
i pDNAddressInformation : 021F:29F ProtocolConfigurationOptions J

Figure 7-26: DUT IP Address Additional Information Options

1. Select the ProtocolConfigurationOptions line. Right-click on ContainerCfgs and change the
content to 3.

2R M Contanercios |

=-3e [00]

----- W Containerld : unknown
g Length : 0

----- o Contents :

-3 [01]

----- & Containerld : unknown
g Length : 0

----- o Contents :

-3 [02]

----- W Containerld : unknown
g Length : 0

..... loon Cnntents :

Figure 7-27: Creating Containerlds for IP Addresses
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[=1-NAS Message List BT:"&” Message Name : UL EMM Message

- SECURITY_MODE_COMMAND
- ATTACH ACCEPT
| ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST

[=1-g2y ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST
i EPSBearerldentity : 5

g ProcedureTransactionldentity : 1

-8, EPSQ0S

I = Nolu B}

I8, AccessPointiame

{ o eemn payt : agilent

PDNAddress

&g spare : PRESENT

PDMType : IPvE (2)

: o PDMAddressInformation : 021 F29FFFET CAFS]

4 Bﬁn‘q ProtocolConfigurationOptions [OPT] ™

i ConfigurationProtocol : 0

T4 ProtocolCfgs

=-T:8 ContainerCfgs
&3 [00]

L ] Containerld ; ,]

Length : 0 'p"Cocr pug Address (1)

""" am CONEENES 1y ON Subsystem Signaling Flag (2)
DNS Server IPve Address (3)

Paolicy Control rejection code (4)
Selected Bearer Control Mode (5)
Resarved (6)

DSMIPvE Home Agent Address (7)
DSMIPvE Home Metwork Prefx (8)
DSMIPvG IPv4 Home Agent Address (9)
Reserved (10)

Reserved (11)

P-CSCF IPv4 Address (12)

DNS Server IPv4 Address (13)
MSISDM (14)

IFOM-Support (15)

IPv4 Link MTU (16)

Figure 7-28: DUT IP Address Additional Information Options

Right-click on Containerld, select “Value Change” and then access the additional information
element options shown in figure 7-26 by selecting the drop-down list.

Use the three containerld fields to select and populate each address for the information

elements:
. P-CSCF IPv6 Address
. DNS Server IPv4 Address
. DNS Server IPv6 Address

The resulting contents are shown in figure 7-29.

The UE IP address is entered in the form 021F:29FF.FE7C:8F51.
The server addresses also include the header information (resulting
in 32 characters), and the colon separators must be omitted.

The UE IPv4 address is entered in dot separated decimal.

The server IPv4 addresses are entered in HEX with no separators.
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Gk ‘e @y
[E1- NAS Message List

-~ SECURITY_MODE_COMMAND
TTM‘I—I_M‘(‘EDT

I ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST

E=e/

=¥ Message Mame : UL EMM Message
&8, ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST
g EPSBearerldentity : 5
i-fg# Procedure TransactionIdentity : 2
-3y, EPSQoS

i Gems teyt : agient

-1-8oy, PDNAddress

g spare : PRESENT

@ PDNType : IPv6 (2)

: - pONAddressInformation : 021F:29FF:FE7C:8F51
301 ProtocolConfigurationOptions [OPT]

i@ ConfigurationProtocol : 0

T8 ProtocolCfgs

=-Tg ContainerCfgs

- 00]
/ [ Containerld : P-CSCF IPv6 Address (1) ™

g Length : 16

----- wo Contents : 2001000000000000021001FFFE234567
Ede [01]

S & Containerld : DNS Server IPv4 Address (13)

. -fg length: 4

| Lomw Contents : COAB0134

=3 [02]

----- ] Containerld : DNS Server IPv6 Address (3)

g Length : 16

----- wwon Contents : 2001000000000000021001FFFE234567

\,

Figure 7-29: DUT IP Address Additional Information Options Final Content

4. Make sure you encode the message by clicking the encode Message button.

If you navigate away from the message before selecting the encode
Message button, your changes will be lost.

The following information message pops-up:

Informing

RRC list.
Do you want to apply to RRC list?

This MAS message is embedded inside a message[RRC Reconfiguration#0] in the

Yes | [ No |

Select ‘Yes’ because you want this new value to be applied in the RRC message. Notice the

“Encode Success” message is displayed in the Output tab window.

Go to the RRC window and notice the RRC Reconfiguration message has turned red. When you

select this RRC message you can see that the value for SEQ 1 has changed. Select the encode
Message icon. The Output tab window now displays “Message is Encoded!” The RRC
Reconfiguration message is now black, which also verifies encoding is successful.
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Rejecting an Incoming AttachRequest

The basic steps to complete this process are as follows. If you already know how to do any of the
steps, they can be skipped and you can focus only on those for which you need help.

. Creating a New NAS Message

. Creating a New RRC Message

. Wrapping it in an RRC Message

. Moadifying Communication Scenario response to incoming AttachRequest

Creating a New NAS Message
1. Create a new NAS message by following the NAS Message Insertion Procedure on page 26.
2. Select ATTACH_REJECT from the Type Name list, and drag it over to the Insert message

area.

3. Click OK. Notice that the new message is added to the NAS Message List.

L NAS Message Insert @I
Messsage Type Hex Value Input
@ DL EMM & ESM Message
= Al
©) UL EMM & ESM Message Pl
Type Name Insert Massage

Message * | | Type Name
ATTACH_ACCEPT drai — DL_EMM ATTACH_REIECT
ATTACH_REIECT

AUTHENTICATION_REIECT
AUTHENTICATION_REQUEST
CS_SERVICE_MOTIFICATION

DETACH_ACCEPT_DL

DETACH_REQUEST_DL

DOWRNLINK_NAS_TRANSPORT

EMM_INFORMATION

EMM_STATUS_DL

GUTI_REALLOCATION_COMMAND

IDENTITY_REQUEST

SECURITY_MODE_COMMAND
SECURITY_PROTECTED_NAS_MESSAGE_DM
SERVICE_REJECT

TRACKING_AREA_UPDATE_ACCEPT
TRACKING_AREA_UPDATE_REIECT
ACTIVATE_DEDICATED_EPS_BEARER_CONTEXT_REQUEST
ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST
BEARER_RESOURCE_ALLOCATION_REIECT
BEARER_RESOURCE_MODIFICATION_REJECT

ACAATIUATE FAC NEARCR AAKTEVT AEALEeT

[

select ok

| peete |[peletest || ok ][ cancel ||

Figure 7-30: Creating New NAS Message

Creating a New RRC Message
1. Select the RRC tab.
2. Then add a new RRC message by selecting the Insert Message icon or Edit, Insert
Message.
3. Select message type as DL-DCCH-Message.
4. Drag it to the Insert Message area.

5. Double-click the Name field and rename it to, Attach_Reject.
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" FOD.Combined 163 = N =

|
POU Type et Hanage

Twoe ] Wakst
[orT S r— DL-DCCH g
BCCH-DL-S04-Hanage add name
MECH-Meniige
POOH-HEsEgE drag

REC Riscont’ DL-LO0H-Mes
RAC Releas
[E T T
Messcrams | PO wmo
DL TAU Acx
DL Detch .
RRC Reconf
RAC Reconf
Page Aglen
FRC Rakease
Measufems
Migsunime
RRC Reconf

: prtn | [oetn s | [Tox ][ concw

Figure 7-31: Inserting New RRC Message
6. Click OK. Notice that the new message is added to the RRC Message List.

™ FDD_Combined_v6.3.lbmf*

o= -
o BlEE -
= RRC Message List
SE!tI..ID
- DL Authentication
- DL Security Command
- Security Mode Command
- UE Capability Enguiry
-~ RRC Reconfiguration
- RRC Release Other
- Page TMSI
- Measurement Report
- DL TAU Accept
-- DL Detach Accept
-- RRC Reconfiguration Re-er|
- RRC Reconfig Second Con
-~ Page Agilent IMSI
- RRC Release TAU
- Measurement Report B13
- Measurement Report B17

-~ RRC Reconfig TAU Accept]
~JAtach_Reject

Wrapping it in an RRC Message
1. Select the new Attach_Reject message.
2. Note that the generic properties of the message you created is csfb to CDOMA2000... This
must be replaced.
3. Right-click in the ¢1 field. Select ‘Type Choice’ when it pops up.

4. From the drop-down list, select dlinformation Transfer.
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™ FDD_Combined v6.3.Jbmf*

@y [E@®e|/

(= RRC Message List =&’ Message Mame @ Attach_Reject
- MIB =-Tg DL-DCCH-Message
SIB1 -Joy, message
5182 - ;ncsﬂ:ParametersResponseCDMAZOOO v]
- Setup e "F8 csfbParametersResponseCDMAZ2000
DL Authentication
DL Security Command = handoverFromEUTRAPreparationRequest
- Security Mode Command mobilityFromEU TRACommand
- UE Capabilty Enquiry rrcConnectionReconfiguration 0000000000" length 32
- RRC Reconfiguration rrcConnectionRelease
- RRC Release Other securityModeCommand
- Page TMSI ueCapabiltyEnquiry th 0
counterCheck
- Measurement Report uelnformationRequest-ra
- DL TAU Accept spare6
- DL Detach Accept spares
RRC Reconfiguration R spare4
- RRC Reconfig Second gon spare3
- Page Agilent IMST spare2
sparel
~ RRC Release TAU
Measurement Reflort B13
- Measurement BBport B17|| petail Information | Output | Hex Viewer
- RRC Reconfig TAU Accept
L Attach_Reject I Name Value

MAME cl
BuiltinMame  CHOICE

Figure 7-32: Selecting Message Properties as dlinformation Transfer
5. Select the nonCriticalExtension field. Then de-select the IE Addition box (at the foot of the

screen) - this removes it from the message.

™ FDD_Combined_v6.3.lbmf*

oBloey |E®e

= RRC Message List -8’ Message Name : Attach_Reject
- MIB =-Fg DL-DCCH-Message
- §IB1 -8y, message
- 5182 =3y c1
- Setup =-Tg dlinformation Transfer
- DL Authentication &g rme-TransactionIdentifier : 0
- DL Security Command =] §u1 criticalExtensions
- Security Mode Command -y 1
- UE Capability Enguiry BE; dlinformation Transfer-r8
- RRC Reconfiguration =] 301 dedicatedInfoType
- RRC Release Other . see dedicatedInfoNAS : " length 0

- Page TMSI =]
- Measurement Report

- DL TAU Accept

- DL Detach Accept

- RRC Reconfiguration Re-er|
- RRC Reconfig Second Con
- Page Agilent IMSI

- RRC Release TAU

- Measurement Report B13

- Measurement Report B17 || petail Information %put Hex Viewer
- RRC Reconfig TAU Accept

-ABF [ateMonCriticalExtension : " length 0
nonCriticalExtension

- Attach_Reject MName Valug
NAME noyCriticalExtension
BuittinMame SUENCE

Reflame Ol Information Transfer-v8a0-IEs
IE addition ¥} de-select

Figure 7-33: De-selecting IE Addition
6. Right-click the dedicatedIinfoNAS field and select ‘Change NAS’.
7. Select the Attach_Reject NAS message from the drop-down list.
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™ FDD_Combined_v6.3.lbmf*

=l

- DL Authentication

- DL Security Command

- Security Mode Command

- UE Capability Enguiry
RRC Reconfiguration

- RRC Release Other

-~ Page TMSI

-~ Measurameant Report

- DL TAU Accept

- DL Detach Accept

-~ RRC Reconfiguration Re-er|
RRC Reconfig Second Con

-~ Page Agient IMSI

- RRC Release TAU

6 ESe|/
= RRC Message List =&’ Message Name : Attach_Reject
- MIB =T DL-DCCH-Message
SIB1 [E)-Boy, message
- SIB2 =B, 1
- Setup =8 Eg dlInformation Transfer

i rrc-TransactionIdentifier : 0
ng criticalExtensions
E-foy c1
=g dinformationTransfer-rg
ey, dedicatedInfoType
- oo BTN TRACKING_AREA_UPDATE_ACCEPT ~)

nonCriticalExtension : (TpaCKING_AREA_UPDATE ACCEPT
ATTACH_ACCEPT
ATTACH_REJECT

- Measurement Report B13
-~ Measurement Report B17

Detail Information | Output

Hex Viewer

-~ RRC Reconfig TAU Acceph
- Attach_Reject Name

NAME
Buitiniame
Reflame
HEXSTR Len

< i | v|| HEXSTR

Value
dedicatedInfoNAS
OCTET STRING
DedicatedInfoNAS
0

Not Encoded

Figure 7-34: Selecting ATTACH_REJECT NAS Message
8. Notice that the RRC name of Attach_Reject has turned red in the left hand RRC Message

List column. This indicates that you have edited the contents of this RRC message and you

must now encode the message. (If you don’t encode the message now, you will lose your

changes.)

Select the encode Message button at the top of the window to encode the message. Verify

that the RRC Attach_Reject message name has turned from red to black (left-hand

window) and that the Output tab text at the bottom of the right-hand window states

success. These both indicate that your encoding was successful.

™ FDD_Combined v6.3.lbmf~

o B o) e s
=~ RRC Message List

- MIB

-~ SIB1

-~ 5IB2

-~ Setup

- DL Authentication

- DL Security Command

- Security Mode Command
- IJE Capability Enguiry

-~ RRC Reconfiguration

-~ RRC Release Other

-~ Page TMSI

-~ Measurement Report

-+ DL TAU Accept

-- DL Detach Accept

-- RRC Reconfiguration Re-ar
-- RRC Reconfig Second Con
-- Page Agilent IMSI

-RRC Release TAU

(-]

e

=P8’ Message Name : Attach_Reject
=-F@ DLPCCH-Message

=)-8ay, fnessage
=- cl
[-Tg diinformation Transfer
-gg® rrc-TransactionIdentifier : 0
=-Bey criticalExtensions
=-gay c1
=-TFg dlinformation Transfer-rg
=13y, dedicatedInfoType

e dedicatedInfoNAS : '074400° length 3

nonCriticalExtension : Optional

-+ Measurement Report B13
-~ Measurement Report B17
Ee g TAL Accepf]

Detail Informatio

Output | Hex Viewer

R n
- Attach_Reject

This Message [Attach_Reject] Encode Success
old Encode Value :
new Encode Value : 0x0800183A2000

0x0080000000006000

Figure 7-35: Verifying Successful Message Encoding

10. Now save the modified scenario file and transfer it to your UXM.
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Modifying Communication Scenario response to incoming AttachRequest

These steps below modify the scenario file to send an Attach_Reject in response to an

Attach_Request.

1. Click on the Scenario tab

2. From the Communication Scenario area select the ‘RRC_Connection (Initial Attach)’

3. Locate the transaction containing the incoming ATTACH_REQUEST. (In this example the

UXM has been set to respond with a DL Authentication message. That must be replaced

with the Attach_Reject message that was created above.)

4. Double-click on the transaction containing the ATTACH_REQUEST (a message editing

window will pop up)

™ FDD_Combined_v6.3.Ibmf*

E

[ Start Scenario Message

MIB

i SIBL

: -sIB2

[ Communication Scenario Mes

B UL_CCCH

- rreConnectionReestabl
i “rrcConnectionRequest

= UL_DCCH

- csfbParametersReques|

- measurementReport

- rrcConnectionReconfig

- rrcConnectionReestabl

~rrcConnectionSetupCo

- securityModeComplete)

- securityModeFailure

- ueCapabilityInformatio

- ulHandoverPreparation

- ullnformation Transfer

- counterCheckRespons:

- uelnformationRespon:

- proximityIndication-

- spare3
spare2
sparel

===

% Message Editin
Start Scenario ? ? @
MIB Type Message UL RRC Message :  mcConnectionSetupComplete [UL_DCCH]
Master Information Block MIB
NasMessage (UL EMM MESSAGE -
[ATTACH REQUEST -
SIB Type MessageName
System Information Block Type 1 SIB1
System Information SIB2 DL RRC Message : IDL Authentication ']
System Information DL Authentication
DL Security Command
Security Mode Command ]
UE Capability Enquiry

Cornmunication Scenatio

RRC_CONNECTION | RRC_CONNECTION_1 | RRC_CONNE
(Initial Attach) \\[Semce Request) (TAU Regffest)

ON_2

RRC Reconfiguration —
RRC Release Other
Measurement Report
RAC_CoN DL TAU Accept

[Ext Seryi DL Detach Accept

= RRC Reconfiguration Re-entry

UL RRC Message \ MAS & Event /

rrcConnectionRequest

Irr(CDrmectiunSetuanmplete ATTACH_REQUEST I
ullnformation Transfer AUTHENTICATION_RESPONSE

ulinformation Transfer SECURITY_MODE_COMPLETE
securityModeComplete
ueCapabilityInformation

ullnformation Transfer
ullnformation Transfer
ullnformation Transfer

AUTHENTICATION_FAILURE
DETACH_REQUEST_UL
PDN_COMNECTIVITY_REQUEST

4 m

Blrrc |1 ..sl'fs:enano I‘ IE

DL RRC Mess RRC Reconfig Second Context
RRC Release TAU

Setup Measurement Report B13

DL Authentic Measurement Report B17
DL Securty ERG Reconfig TAU Accept

M ttach Reject
SECUrty Modiscmbsm——

UE Capabilty Enguiry

RRC Reconfiguration

DL Authentication

DL Detach Accept

RRC Reconfig Second Context

4| mn

Figure 7-36: Modifying Response to Incoming AttachRequest
5. From the DL RRC MESSAGE drop-down list select Attach_Reject

6. Click OK.

7. The transaction should now show Attach_Reject in response to the ATTACH_REQUEST.
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-a/q

Communication Scenario

RRC_CONNECTION | RRC_CONNECTI 1 | RRC_COMMECTION_ 2 | RRC_CONMECTION_3
{Indtial Attach) _l{SEnnr.e Request (TAL Request) (Ext Sendce Requast) |

UL RRC Message

meConnectonRequest

ullnformation Transfer : [ i

ullnformation Transfer SECURITY_MODE_COMPLETE Securfty Mode l:ommnd
securtyModeComplete _ UE Capabiity Enquiry
ueCapabistyTnformation 5 RRC Reconfiguration
ulinformation Transfer AUTHENTICATION_FAILURE DL Authentication
wlinformation Transfer DETACH_REQUEST_UIL DL Detach Accept
winformation Transfer PON_CONNECTIVITY_REQUEST  RRC Reconfi Second Context

Figure 7-37: Saving Attach_Reject Response to Incoming AttachRequest

8. Now save the scenario and transfer it to your UXM.
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8 Service and Support

Calling Keysight Technologies

Keysight Technologies has offices around the world to provide you with complete support for your
products. For help, to obtain servicing information or to order replacement parts, contact the
nearest Keysight Technologies office listed below. In any correspondence or telephone
conversations, you will need the product number, full serial number, and software revision details.
Select the System, App Info front panel key to view the product number (E7515A), serial number,
and software revision information.
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Locations for Keysight Technologies

Online assistance: http://www.keysight.com/find/assist
If you do not have access to the Internet, one of these centers can direct you to your nearest

representative:
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Should the Declaration of Conformity be required, please contact a Keysight Sales Representative,
or the closest Keysight Sales Office. Alternately, contact Keysight at: www.keysight.com.

Americas

Brazil Canada

5511 3351 7010 (877) 894 4414
United States

(800) 829 4444

Asia Pacific

Australia India

1800 629 485 1800112929
China Japan

800 8100189 0120 (421) 345
Hong Kong Korea

800 938 693 080 769 0800
Other Asian Countries:

(65) 6375 8100

www.keysight.com/find/contactus

Europe & Middle East

Austria Ireland
080000 11 22 1800 832 700
Belgium Israel

0800 58 580 1809 343 051
Finland [taly

0800 523 252 800 599 100
France Luxembourg
0805 980 333 +32 800 58580
*0.125 €/minute Netherlands
Germany 0800 0233 200
0800 6270 999

Other Unlisted Countries:
www.keysight.com/find/contactus

Sl

Mexico
001 800 254 2440

Malaysia

1 800 888 848
Singapore
1800 375 8100
Taiwan

0800 047 866

Russia

8800 5009 286
Spain

0800 00 01 54
Sweden

0200 88 22 55
Switzerland
0800 80 53 53
United Kingdom
0800 0260 637


http://www.keysight.com/find/assist
http://www.keysight.com/
http://www.keysight.com/find/contactus
http://www.keysight.com/find/contactus
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